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Environment Requirements

In order to set up this experience, you will need:

» One of the following versions:
@ V5-6R2015
@ V6 R2013x
@ 3DEXPERIENCE R2015x

» An access to the following servers:
@ ENOVIAV6R2013x server
@ 3DEXPERIENCE Cloud

» The following license:
@ CATIAPLM DISCOVER

» To import on your computer:
@ Stereo_model.3dxml (provided in the course)

» To install on your computer:
@ AMD Drivers (provided in the course)

» To download and install on the internet:
@ Logitech Drivers
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What is Active shutter 3D system?

An active shutter 3D system is a must-have tool in project-based learning, electronic prototyping and
making.

» Itis atechnique of displaying stereoscopic 3D images.

»  When the image intended for the left eye is displayed, the right eye's vision is blocked and vice versa. This
process is repeated so rapidly that the interruptions do not interfere with the perceived fusion of the two
images into a single 3D image.

»  Modern active shutter 3D systems generally use liquid crystal shutter glasses. Each eye's glass contains
a liquid crystal layer which becomes opaque when voltage is applied, or, otherwise, remains transparent.

»  Atiming signal allows the glasses to alternately block one eye, and then the other, in synchronization with
the refresh rate of the screen. The timing synchronization to the video equipment may be achieved via a
wired signal, or wirelessly by either an infrared or radio frequency transmitter.

In our case the signal will be transmitted wirelessly by the TV thanks to the 3D graphic card.
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How does it work?

» Desktop Computer
© The desktop computer represents the structure of this 3D Experience.
© It has to be powerful enought to run CATIA.

» 3D Graphic Card
© The 3D graphic card represents the heart of this 3D Experience.
© It will replace the standard graphic card you have on your current desktop computer.

» 3D Screen
© Connected to the 3D graphic card, it will decode the active signal and display the images.

O Atthe same time, it will transmit another signal, coming from the 3D graphic card, to the 3D
glasses.

» 3D Glasses

© The 3D glasses will use the signal coming from the graphic card to switch from the right-eye
Image to the left-eye image.




What is in this package?

In this package you will find:

@ AMD dedicated drivers for the 3D graphic card
@ Logitech dedicated drivers for the space mouse (optional)
@ A 3D Model to test your configuration



Where to buy components

Example of configuration:

Desktop Computer: DELL PRECISION TOWER 5810

Intel® Xeon® CPU E5-1620 v3 @ 3.50GHz — 16 GB — 64-bit OS
http://www.dell.com/us/business/p/precision-t5810-workstation/pd?refid=precision-t5810-
workstation&baynote bnrank=0&baynote irrank=0&~ck=baynoteSearch&isredir=true

Graphic Card: AMD FirePro W7100 (FireGL V)
http://www.amd.com/en-us/products/graphics/workstation/firepro-3d/7100#
http://shop.amd.com/en-us/search/100505724

HDMI Cable 1.4 3D version:
http://www.amazon.com/IBRA%C2%AE-PRO-GOLD-RED-1-5M/dp/B0031APPM4/ref=sr 1 4?ie=UTF8&qid=1430987332&sr=8-
4&keywords=hdmi+1.4

HDMI to DisplayPort Adaptator: Active DisplayPort to HDMI Male to Female Adapter
http://www.amazon.com/Cable-Matters%C2%AE-Plated-DisplayPort-
Adapter/dp/BOOEDT0072/ref=sr 1 1?ie=UTF8&qid=1430987617&sr=8-1&keywords=active+hdmi+to+displayport

FR : 400 Hz Active 3D Screen: UE75H6400
http://www.samsung.com/fr/consumer/tv-audio-video/television/tv-led/UE75H6400AWXZF

US: 400 Hz Active 3D Screen: LED F7100 Series
http://www.samsung.com/us/video/tvs/lUN75F7100AFXZA

Rechargeable 3D Active Glasses (optional): SSG-3570CR/ZA
http://www.samsung.com/us/video/tvs-accessories/SSG-3570CR/ZA

Mouse and Keyboard Wireless (optional): Logitech Wireless Combo MK520
http://www.amazon.com/Logitech-Wireless-Combo-Mk520-
Keyboard/dp/BOO3VANO7C/ref=sr 1 1?ie=UTF8&0id=1430987835&sr=8-1&keywords=mk520

Space mouse (optional): SpaceMouse Wireless 3D Mouse (3DX-700043)
http://www.amazon.com/3Dconnexion-SpaceMouse-Wireless-Mouse-3DX-
700043/dp/BOOFJRRVIl/ref=sr 1 2?ie=UTF8&0id=1430991829&sr=8-2&keywords=space-+navigator

Wall mount (optional): 75inch
http://www.amazon.com/Impact-Mounts-Lockable-Installers-
Throughout/dp/BOOBTORT8Q/ref=sr 1 227?s=electronics&ie=UTF8&qid=1430989851&sr=1-22&keywords=wall+mount

$1199

$659.99

$14.95
$19.99

$3799.99

$49.99
$34.99

$93.00

$21.99

AMD FREpR)



http://www.dell.com/us/business/p/precision-t5810-workstation/pd?refid=precision-t5810-workstation&baynote_bnrank=0&baynote_irrank=0&~ck=baynoteSearch&isredir=true
http://www.dell.com/us/business/p/precision-t5810-workstation/pd?refid=precision-t5810-workstation&baynote_bnrank=0&baynote_irrank=0&~ck=baynoteSearch&isredir=true
http://www.dell.com/us/business/p/precision-t5810-workstation/pd?refid=precision-t5810-workstation&baynote_bnrank=0&baynote_irrank=0&~ck=baynoteSearch&isredir=true
http://www.dell.com/us/business/p/precision-t5810-workstation/pd?refid=precision-t5810-workstation&baynote_bnrank=0&baynote_irrank=0&~ck=baynoteSearch&isredir=true
http://www.dell.com/us/business/p/precision-t5810-workstation/pd?refid=precision-t5810-workstation&baynote_bnrank=0&baynote_irrank=0&~ck=baynoteSearch&isredir=true
http://www.dell.com/us/business/p/precision-t5810-workstation/pd?refid=precision-t5810-workstation&baynote_bnrank=0&baynote_irrank=0&~ck=baynoteSearch&isredir=true
http://www.dell.com/us/business/p/precision-t5810-workstation/pd?refid=precision-t5810-workstation&baynote_bnrank=0&baynote_irrank=0&~ck=baynoteSearch&isredir=true
http://www.dell.com/us/business/p/precision-t5810-workstation/pd?refid=precision-t5810-workstation&baynote_bnrank=0&baynote_irrank=0&~ck=baynoteSearch&isredir=true
http://www.dell.com/us/business/p/precision-t5810-workstation/pd?refid=precision-t5810-workstation&baynote_bnrank=0&baynote_irrank=0&~ck=baynoteSearch&isredir=true
http://www.amd.com/en-us/products/graphics/workstation/firepro-3d/7100
http://www.amd.com/en-us/products/graphics/workstation/firepro-3d/7100
http://www.amd.com/en-us/products/graphics/workstation/firepro-3d/7100
http://www.amd.com/en-us/products/graphics/workstation/firepro-3d/7100
http://www.amd.com/en-us/products/graphics/workstation/firepro-3d/7100
http://shop.amd.com/en-us/search/100505724
http://shop.amd.com/en-us/search/100505724
http://shop.amd.com/en-us/search/100505724
http://www.amazon.com/IBRA%C2%AE-PRO-GOLD-RED-1-5M/dp/B0031APPM4/ref=sr_1_4?ie=UTF8&qid=1430987332&sr=8-4&keywords=hdmi+1.4
http://www.amazon.com/IBRA%C2%AE-PRO-GOLD-RED-1-5M/dp/B0031APPM4/ref=sr_1_4?ie=UTF8&qid=1430987332&sr=8-4&keywords=hdmi+1.4
http://www.amazon.com/IBRA%C2%AE-PRO-GOLD-RED-1-5M/dp/B0031APPM4/ref=sr_1_4?ie=UTF8&qid=1430987332&sr=8-4&keywords=hdmi+1.4
http://www.amazon.com/IBRA%C2%AE-PRO-GOLD-RED-1-5M/dp/B0031APPM4/ref=sr_1_4?ie=UTF8&qid=1430987332&sr=8-4&keywords=hdmi+1.4
http://www.amazon.com/IBRA%C2%AE-PRO-GOLD-RED-1-5M/dp/B0031APPM4/ref=sr_1_4?ie=UTF8&qid=1430987332&sr=8-4&keywords=hdmi+1.4
http://www.amazon.com/IBRA%C2%AE-PRO-GOLD-RED-1-5M/dp/B0031APPM4/ref=sr_1_4?ie=UTF8&qid=1430987332&sr=8-4&keywords=hdmi+1.4
http://www.amazon.com/IBRA%C2%AE-PRO-GOLD-RED-1-5M/dp/B0031APPM4/ref=sr_1_4?ie=UTF8&qid=1430987332&sr=8-4&keywords=hdmi+1.4
http://www.amazon.com/IBRA%C2%AE-PRO-GOLD-RED-1-5M/dp/B0031APPM4/ref=sr_1_4?ie=UTF8&qid=1430987332&sr=8-4&keywords=hdmi+1.4
http://www.amazon.com/IBRA%C2%AE-PRO-GOLD-RED-1-5M/dp/B0031APPM4/ref=sr_1_4?ie=UTF8&qid=1430987332&sr=8-4&keywords=hdmi+1.4
http://www.amazon.com/IBRA%C2%AE-PRO-GOLD-RED-1-5M/dp/B0031APPM4/ref=sr_1_4?ie=UTF8&qid=1430987332&sr=8-4&keywords=hdmi+1.4
http://www.amazon.com/IBRA%C2%AE-PRO-GOLD-RED-1-5M/dp/B0031APPM4/ref=sr_1_4?ie=UTF8&qid=1430987332&sr=8-4&keywords=hdmi+1.4
http://www.amazon.com/IBRA%C2%AE-PRO-GOLD-RED-1-5M/dp/B0031APPM4/ref=sr_1_4?ie=UTF8&qid=1430987332&sr=8-4&keywords=hdmi+1.4
http://www.amazon.com/IBRA%C2%AE-PRO-GOLD-RED-1-5M/dp/B0031APPM4/ref=sr_1_4?ie=UTF8&qid=1430987332&sr=8-4&keywords=hdmi+1.4
http://www.amazon.com/Cable-Matters%C2%AE-Plated-DisplayPort-Adapter/dp/B00EDT0072/ref=sr_1_1?ie=UTF8&qid=1430987617&sr=8-1&keywords=active+hdmi+to+displayport
http://www.amazon.com/Cable-Matters%C2%AE-Plated-DisplayPort-Adapter/dp/B00EDT0072/ref=sr_1_1?ie=UTF8&qid=1430987617&sr=8-1&keywords=active+hdmi+to+displayport
http://www.amazon.com/Cable-Matters%C2%AE-Plated-DisplayPort-Adapter/dp/B00EDT0072/ref=sr_1_1?ie=UTF8&qid=1430987617&sr=8-1&keywords=active+hdmi+to+displayport
http://www.amazon.com/Cable-Matters%C2%AE-Plated-DisplayPort-Adapter/dp/B00EDT0072/ref=sr_1_1?ie=UTF8&qid=1430987617&sr=8-1&keywords=active+hdmi+to+displayport
http://www.amazon.com/Cable-Matters%C2%AE-Plated-DisplayPort-Adapter/dp/B00EDT0072/ref=sr_1_1?ie=UTF8&qid=1430987617&sr=8-1&keywords=active+hdmi+to+displayport
http://www.amazon.com/Cable-Matters%C2%AE-Plated-DisplayPort-Adapter/dp/B00EDT0072/ref=sr_1_1?ie=UTF8&qid=1430987617&sr=8-1&keywords=active+hdmi+to+displayport
http://www.amazon.com/Cable-Matters%C2%AE-Plated-DisplayPort-Adapter/dp/B00EDT0072/ref=sr_1_1?ie=UTF8&qid=1430987617&sr=8-1&keywords=active+hdmi+to+displayport
http://www.amazon.com/Cable-Matters%C2%AE-Plated-DisplayPort-Adapter/dp/B00EDT0072/ref=sr_1_1?ie=UTF8&qid=1430987617&sr=8-1&keywords=active+hdmi+to+displayport
http://www.amazon.com/Cable-Matters%C2%AE-Plated-DisplayPort-Adapter/dp/B00EDT0072/ref=sr_1_1?ie=UTF8&qid=1430987617&sr=8-1&keywords=active+hdmi+to+displayport
http://www.amazon.com/Cable-Matters%C2%AE-Plated-DisplayPort-Adapter/dp/B00EDT0072/ref=sr_1_1?ie=UTF8&qid=1430987617&sr=8-1&keywords=active+hdmi+to+displayport
http://www.amazon.com/Cable-Matters%C2%AE-Plated-DisplayPort-Adapter/dp/B00EDT0072/ref=sr_1_1?ie=UTF8&qid=1430987617&sr=8-1&keywords=active+hdmi+to+displayport
http://www.samsung.com/fr/consumer/tv-audio-video/television/tv-led/UE75H6400AWXZF
http://www.samsung.com/fr/consumer/tv-audio-video/television/tv-led/UE75H6400AWXZF
http://www.samsung.com/fr/consumer/tv-audio-video/television/tv-led/UE75H6400AWXZF
http://www.samsung.com/fr/consumer/tv-audio-video/television/tv-led/UE75H6400AWXZF
http://www.samsung.com/fr/consumer/tv-audio-video/television/tv-led/UE75H6400AWXZF
http://www.samsung.com/fr/consumer/tv-audio-video/television/tv-led/UE75H6400AWXZF
http://www.samsung.com/fr/consumer/tv-audio-video/television/tv-led/UE75H6400AWXZF
http://www.samsung.com/us/video/tvs/UN75F7100AFXZA
http://www.samsung.com/us/video/tvs-accessories/SSG-3570CR/ZA
http://www.samsung.com/us/video/tvs-accessories/SSG-3570CR/ZA
http://www.samsung.com/us/video/tvs-accessories/SSG-3570CR/ZA
http://www.samsung.com/us/video/tvs-accessories/SSG-3570CR/ZA
http://www.samsung.com/us/video/tvs-accessories/SSG-3570CR/ZA
http://www.amazon.com/Logitech-Wireless-Combo-Mk520-Keyboard/dp/B003VANO7C/ref=sr_1_1?ie=UTF8&qid=1430987835&sr=8-1&keywords=mk520
http://www.amazon.com/Logitech-Wireless-Combo-Mk520-Keyboard/dp/B003VANO7C/ref=sr_1_1?ie=UTF8&qid=1430987835&sr=8-1&keywords=mk520
http://www.amazon.com/Logitech-Wireless-Combo-Mk520-Keyboard/dp/B003VANO7C/ref=sr_1_1?ie=UTF8&qid=1430987835&sr=8-1&keywords=mk520
http://www.amazon.com/Logitech-Wireless-Combo-Mk520-Keyboard/dp/B003VANO7C/ref=sr_1_1?ie=UTF8&qid=1430987835&sr=8-1&keywords=mk520
http://www.amazon.com/Logitech-Wireless-Combo-Mk520-Keyboard/dp/B003VANO7C/ref=sr_1_1?ie=UTF8&qid=1430987835&sr=8-1&keywords=mk520
http://www.amazon.com/Logitech-Wireless-Combo-Mk520-Keyboard/dp/B003VANO7C/ref=sr_1_1?ie=UTF8&qid=1430987835&sr=8-1&keywords=mk520
http://www.amazon.com/Logitech-Wireless-Combo-Mk520-Keyboard/dp/B003VANO7C/ref=sr_1_1?ie=UTF8&qid=1430987835&sr=8-1&keywords=mk520
http://www.amazon.com/Logitech-Wireless-Combo-Mk520-Keyboard/dp/B003VANO7C/ref=sr_1_1?ie=UTF8&qid=1430987835&sr=8-1&keywords=mk520
http://www.amazon.com/Logitech-Wireless-Combo-Mk520-Keyboard/dp/B003VANO7C/ref=sr_1_1?ie=UTF8&qid=1430987835&sr=8-1&keywords=mk520
http://www.amazon.com/Logitech-Wireless-Combo-Mk520-Keyboard/dp/B003VANO7C/ref=sr_1_1?ie=UTF8&qid=1430987835&sr=8-1&keywords=mk520
http://www.amazon.com/Logitech-Wireless-Combo-Mk520-Keyboard/dp/B003VANO7C/ref=sr_1_1?ie=UTF8&qid=1430987835&sr=8-1&keywords=mk520
http://www.amazon.com/3Dconnexion-SpaceMouse-Wireless-Mouse-3DX-700043/dp/B00FJRRVII/ref=sr_1_2?ie=UTF8&qid=1430991829&sr=8-2&keywords=space+navigator
http://www.amazon.com/3Dconnexion-SpaceMouse-Wireless-Mouse-3DX-700043/dp/B00FJRRVII/ref=sr_1_2?ie=UTF8&qid=1430991829&sr=8-2&keywords=space+navigator
http://www.amazon.com/3Dconnexion-SpaceMouse-Wireless-Mouse-3DX-700043/dp/B00FJRRVII/ref=sr_1_2?ie=UTF8&qid=1430991829&sr=8-2&keywords=space+navigator
http://www.amazon.com/3Dconnexion-SpaceMouse-Wireless-Mouse-3DX-700043/dp/B00FJRRVII/ref=sr_1_2?ie=UTF8&qid=1430991829&sr=8-2&keywords=space+navigator
http://www.amazon.com/3Dconnexion-SpaceMouse-Wireless-Mouse-3DX-700043/dp/B00FJRRVII/ref=sr_1_2?ie=UTF8&qid=1430991829&sr=8-2&keywords=space+navigator
http://www.amazon.com/3Dconnexion-SpaceMouse-Wireless-Mouse-3DX-700043/dp/B00FJRRVII/ref=sr_1_2?ie=UTF8&qid=1430991829&sr=8-2&keywords=space+navigator
http://www.amazon.com/3Dconnexion-SpaceMouse-Wireless-Mouse-3DX-700043/dp/B00FJRRVII/ref=sr_1_2?ie=UTF8&qid=1430991829&sr=8-2&keywords=space+navigator
http://www.amazon.com/3Dconnexion-SpaceMouse-Wireless-Mouse-3DX-700043/dp/B00FJRRVII/ref=sr_1_2?ie=UTF8&qid=1430991829&sr=8-2&keywords=space+navigator
http://www.amazon.com/3Dconnexion-SpaceMouse-Wireless-Mouse-3DX-700043/dp/B00FJRRVII/ref=sr_1_2?ie=UTF8&qid=1430991829&sr=8-2&keywords=space+navigator
http://www.amazon.com/3Dconnexion-SpaceMouse-Wireless-Mouse-3DX-700043/dp/B00FJRRVII/ref=sr_1_2?ie=UTF8&qid=1430991829&sr=8-2&keywords=space+navigator
http://www.amazon.com/3Dconnexion-SpaceMouse-Wireless-Mouse-3DX-700043/dp/B00FJRRVII/ref=sr_1_2?ie=UTF8&qid=1430991829&sr=8-2&keywords=space+navigator
http://www.amazon.com/3Dconnexion-SpaceMouse-Wireless-Mouse-3DX-700043/dp/B00FJRRVII/ref=sr_1_2?ie=UTF8&qid=1430991829&sr=8-2&keywords=space+navigator
http://www.amazon.com/3Dconnexion-SpaceMouse-Wireless-Mouse-3DX-700043/dp/B00FJRRVII/ref=sr_1_2?ie=UTF8&qid=1430991829&sr=8-2&keywords=space+navigator
http://www.amazon.com/Impact-Mounts-Lockable-Installers-Throughout/dp/B00BT0RT8Q/ref=sr_1_22?s=electronics&ie=UTF8&qid=1430989851&sr=1-22&keywords=wall+mount
http://www.amazon.com/Impact-Mounts-Lockable-Installers-Throughout/dp/B00BT0RT8Q/ref=sr_1_22?s=electronics&ie=UTF8&qid=1430989851&sr=1-22&keywords=wall+mount
http://www.amazon.com/Impact-Mounts-Lockable-Installers-Throughout/dp/B00BT0RT8Q/ref=sr_1_22?s=electronics&ie=UTF8&qid=1430989851&sr=1-22&keywords=wall+mount
http://www.amazon.com/Impact-Mounts-Lockable-Installers-Throughout/dp/B00BT0RT8Q/ref=sr_1_22?s=electronics&ie=UTF8&qid=1430989851&sr=1-22&keywords=wall+mount
http://www.amazon.com/Impact-Mounts-Lockable-Installers-Throughout/dp/B00BT0RT8Q/ref=sr_1_22?s=electronics&ie=UTF8&qid=1430989851&sr=1-22&keywords=wall+mount
http://www.amazon.com/Impact-Mounts-Lockable-Installers-Throughout/dp/B00BT0RT8Q/ref=sr_1_22?s=electronics&ie=UTF8&qid=1430989851&sr=1-22&keywords=wall+mount
http://www.amazon.com/Impact-Mounts-Lockable-Installers-Throughout/dp/B00BT0RT8Q/ref=sr_1_22?s=electronics&ie=UTF8&qid=1430989851&sr=1-22&keywords=wall+mount
http://www.amazon.com/Impact-Mounts-Lockable-Installers-Throughout/dp/B00BT0RT8Q/ref=sr_1_22?s=electronics&ie=UTF8&qid=1430989851&sr=1-22&keywords=wall+mount
http://www.amazon.com/Impact-Mounts-Lockable-Installers-Throughout/dp/B00BT0RT8Q/ref=sr_1_22?s=electronics&ie=UTF8&qid=1430989851&sr=1-22&keywords=wall+mount
http://www.amazon.com/Impact-Mounts-Lockable-Installers-Throughout/dp/B00BT0RT8Q/ref=sr_1_22?s=electronics&ie=UTF8&qid=1430989851&sr=1-22&keywords=wall+mount
http://www.amazon.com/Impact-Mounts-Lockable-Installers-Throughout/dp/B00BT0RT8Q/ref=sr_1_22?s=electronics&ie=UTF8&qid=1430989851&sr=1-22&keywords=wall+mount

Where to buy the components

Prerequisites for the TV:

In our lab we use this screen:
FR : 400 Hz Active 3D Screen : UE75H6400
http://www.samsung.com/fr/consumer/tv-audio-video/television/tv-led/ UE75H6400AWXZF

You can find this model in the US:

US: 400 Hz Active 3D Screen : LED F7100 Series
http://www.samsung.com/us/video/tvs/UN75F7100AFXZA

If you want another TV model you will need:
120 hz screen
3D active

2 300 €

$3799.99
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How to set up the devices

® Installing the drivers
@ Launch the AMD shortcut and follow the instructions (no custom installation)
@ Launch the LOGITECH shortcut and follow the instructions (no custom installation)

® Installing the graphic card
@ In your computer, replace the old graphic card by the new W7100 3D graphic card

» Connecting the desktop computer to the screen
@ Use the 1.4 HDMI cable to connect the screen to the adaptor
@ Connect the adaptor to the new graphic card you have installed in computer



How to set up the stereo

Use the following steps to set up your version of CATIA V5:

Click on Tools > Options > General > Display > Visualization

Click on the Devices tab

Click on On next to Stereo option to enable steroscopic viewing

Click on OK

Restart your session to save your settings

Enter the following command: c:Stereoscopic inthe power input field and press Enter
Set the Stereo option to On to enable steroscopic viewing

To set the distance between your eyes in Manual mode, type it in the corresponding field.
Click on OK

© 0N A WNRE



How to set up the stereo

Use the following steps to set up your version of CATIA V6:

Click on Tools > Options > General > Immersive Virtuality

Click on the Immersive Configuration tab

Check the box to enable stereoscopic display

Click on OK

Restart your session to save the settings

Go to tab View > Toolbars > General > Immersive Virtuality

Check the box Immersive Virtuality to display the associate toolbar
Click on the little arrow to open a submenu and set up this type of 3D:

© NO bk wNPRE
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How to set up the stereo

Use the following steps to set up the SDEXPERIENCE:

Click on profile picture and select Preferences
Click on the Immersive Configuration tab
Check the box to enable stereoscopic display
Click on OK

Restart your session to save your settings

Go to panel called View

Click on this arrow ® to display the submenu
Click on the little arrow next to this button: @]
Set the Active or Passive Stereoscopy

This cursor appears: @
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Tips

To iImprove your stereoscopic experience, here are some tips:

® 3 buttons mouse without secondary buttons on the wheel:

® Click on the wheel button to refocus the 3D:




